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ASCENT, Senior Instructional Designer  

Learning Objectives 
• Learn how to create conceptual grading plans and parking lots inside InfraWorks 360. 

• Learn how to transfer the design to AutoCAD Civil 3D to create the detailed design. 

• Learn how to compute quantity takeoffs for the earthworks and material volumes. 

• Learn how to communicate the design visually with InfraWorks 360. 

Description 
Helping the community visualize a project’s impact before construction is complete can be very difficult unless you 
use the right tools for the job. This class explores conceptual site-design options using InfraWorks 360 software to 
visualize realistic proposed sites. Starting with Model Builder and Revit software models, you will learn how to 
create realistic and accurate models that support a more informative and productive public-communication model. 
After clearly demonstrating the conceptual and preliminary design to stakeholders, we take the design into 
AutoCAD Civil 3D software to run quantity takeoffs and finish the detailed design. The design is then taken back 
into InfraWorks 360 software to create high-impact visuals to better support public participation and 
communication. We will perform various types of analysis along the way to validate the design and ensure design 
parameters are being met.  

Your AU Experts 
Michelle Rasmussen has been using AutoCAD since release 9. Starting out in the Civil Engineering Unit of 
the U.S. Air Force, she has used Softdesk, Land Desktop, Civil 3D, and InfraWorks on infrastructure 
projects for more than 20 years. She has worked for both consulting engineering firms and municipalities 
laying out subdivisions, designing roadways, and managing infrastructure projects. Her extensive 
experience also includes writing training guides and instructing users how to use the Autodesk 
Infrastructure software product line. As a Senior Instructional Designer at ASCENT, Michelle currently 
writes courseware for AutoCAD, AutoCAD Civil 3D, AutoCAD Map 3D, Autodesk Infrastructure Design 
Suite and Autodesk InfraWorks. The training guides she writes are used by Instructors, students, schools 
and ATC’s in over 67 countries. 
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Objective 1: Create Conceptual Grading Plans 
Create Coverages in a Model 
Coverages are used to shape the terrain and change the way the ground displays. Coverages can be used 
to add ground cover in a landscape design, set the elevation of a building pad, or create a parking lot for 
a site design. Additionally, Terrain Hole material can be used on a coverage to create openings in a 
surface with a clean edge. This enables you to display what is going on underground. Whether you want 
to cut holes in a surface to indicate the station entrances of rail lines or display how utilities are to be 
laid out, you can use the Terrain Hole material assigned to a coverage. If you just need to reshape the 
terrain surface without changing how it displays, a transparent material style can be used. 

Edit Coverages 
Once a coverage has been created, it can be re-shaped using  (Control Point Gizmo). The gizmos are 
displayed at each vertex when the coverage is selected in the model. If you orbit the model more than 

45 degrees,  (Elevation Gizmo) displays and can be used to adjust the elevation of each corner. As you 
adjust the elevation of a coverage, the surrounding terrain updates to gradually slope toward the new 
elevation, as shown in Figure 1. 

 
Figure 1 

How gradual the slope is depends on the Smooth Radius value for the coverage, as shown in Figure 2. 
This value is changed by right-clicking on the coverage and selecting Properties. In the Properties 
palette, change the Smooth Radius value and click Update. 
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Figure 2 

Vertices can be added anywhere along a side to add additional control and elevation points. To add a 
vertex, select the coverage, right-click on the side that you want to have additional control over, and 
select Add Vertex, as shown in Figure 3. 

 
Figure 3 

Exercise: Create Coverages in the Model 
In this exercise you will shape the ground surface 
in preparation for a school. You will create a 
coverage and adjust its elevations. 

1. Open the InfraWorks 360 software. If 
asked for a login, put in the following 
credentials: 

• Autodesk ID: auexpert2015 
• Password: Passwd123! 

2. In the Home Screen, click Open. 

3. In the C:\CI11140-L_Grading folder, select 
Grading.sqlite and then click Open.  

4. In the Utility Bar, click  (Bookmark your 
current location) and select School. Also 
make sure the current proposal is set to 
Coverage. 

5. In the In Canvas Tools, click  (Build, 
manage, and analyze your infrastructure 
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model)>  (Create conceptual design 
features)>  (Coverages). 

6. In the Select Draw Style asset card, select 
Asphalt.  

7. In the model, click to place the corners of 
the asphalt slab in the field reserved for 
the school, as shown in Figure 4. Make 
the measurement 350’ x 300’ with the 
long side running east to west. Double-
click on the last corner to place it and end 
the command. 

 
Figure 4 

8. In the Utility Bar, click  (Edit). 
9. With the new asphalt coverage still 

selected, orbit the view so that the 
elevation of the south side is displayed, as 
shown in Figure 5.  

• A box displays indicating orthogonal 
directions otherwise known as level lines. 

The level line in the view can help you to 
level the pad.  

 
Figure 5 

10. Right-click and select Shape Terrain.  

11. Clcik  (Elevation Gizmo) to make change 
the elevation. In the elevation field, type 
4612, as shown in Figure 6.  

• The surrounding ground gradually slopes 
into the school pad based on the changes 
in elevation and Smooth Radius value in 
the Coverage Area Properties. 

 

Figure 6 

12. With the coverage still selected, right-
click and select Properties. 

13. In the Properties palette, change the 
Smooth Radius value to 20 and click 
Update.  

14. Note the change in the surrounding 
grade. Then change the Smooth Radius 
value to 90 and click Update. Close the 
Properties palette. 

15. Press <Esc> to clear the selection of the 
newly created school pad. 
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Create Land Areas  
Similar to coverages, land areas provide a way for you to grade areas and change how the terrain 
displays. There are two key differences that land areas provide over coverages: 

• The top surface of a land area is automatically flattened, as shown in Figure 7. A coverage 
drapes on the surface until the terrain is manually shaped. 

• Land areas enable you to control the display of cut and fill areas separately. Figure 7 shows a 
land area with a 3:1 grass material for the fill and a 1:1 stone wall material for the cut. 

 
Figure 7 

Grading Styles 
Grading styles control how the cut and fill slopes display. Several grading styles are provided in the 
Autodesk InfraWorks software (as shown on the left in Figure 8) and additional styles can be created as 
required. The thumbnails in the Style palette display a preview of the materials and slopes that are used 
in each style. If the cut and fill slopes use the same material, only one material is shown in the 
thumbnail. If the cut and fill slopes use different materials, both materials display in the thumbnail with 
their slope values, as shown on the right in Figure 8.  

 
Figure 8 

Edit Land Areas 
Once a land area has been created, it can be re-shaped using  (Control Point Gizmo). The gizmos are 
displayed at each vertex when the land area is selected in the model. By default, land area top surfaces 
are flat with all of the footprint vertices sharing the same elevation. If the model is orbited more than 45 
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degrees,  (Elevation Gizmos) display and can be used to adjust the elevation of each vertex 
independently.  

Vertices can be added anywhere along a side to add additional control and elevation points. To add a 
vertex, select the land area, right-click on the point at which you want to have additional control, and 
select Add Vertex, as shown in Figure 9. 

 
Figure 9 

Exercise: Grade a Parking Lot Using a Land Area (Preview)
In this exercise you will use land areas to create a 
parking lot for the white water park, setting the 
cut and fill slope displays separately. You will then 
add another land area with a gradual slope 
covered in grass for the patrons to access the 
river. 

Task 1: Create a new grading style. 
In this task, you will create a new grading style 
which uses river stone for the cut and grass for 
the fill of the proposed parking lot. 

1. Continue working in the same model. If 
you closed it, open Grading.sqlite in the 
C:\CI11140-L_Grading folder.  

2. In the Utility Bar, expand Switch Active 
Proposal and select LandAreas. 

3. In Utility Bar, click  (Bookmark your 
current location) and select River. 

4. Open the Style palette and select the 
Grading tab. 

5. In the Style Editing area at the bottom of 
the Style palette, click  (Add new style to 
the current catalog above). 

6. In the Define New Grading dialog box, set 
the Grading Method to Fixed Slope. 

7. Set the following options, as shown in 
Figure 10. 

• Cut Slope: 1:1 

• Fill Slope: 4:1 
• Clear the checkbox for Cut and Fill 

Material use the same Style. 
• Cut Material: Select 

Material>Land Cover>Riverstone. 
• Fill Material: Select Material>Land 

Cover>Manicured Grass. 
• Clear the checkbox for Set 

Grading Limit. 
• Click OK. 

 
Figure 10 

8. Type Parking for the name. 
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Task 2: Create a parking lot and grass area for 
park patrons. 
In this task, you will create a parking lot for the 
white water park patrons and a grass area which 
provides a more gradual slope to the river on the 
south side. 

1. Continue working in the same model as 
the last task. If you did not complete the 
last task, you can use the RiverParking 
style when called for. 

2. In the In Canvas tools, click  (Build, 
manage and analyze your infrastructure 
model) >  (Create conceptual design 
features) >  (Land Areas). 

3. In the Select Draw Style asset card that 
displays, type PK and select PK-Lot, as 
shown in Figure 11. 

 
Figure 11 

• This style is used for the land area top 
surface only, not the cut and fill slopes. 
The cut and fill styles are set later. 

4. In the model, click to place the first vertex 
of the land area footprint, as shown in 
Figure 12. 

 
Figure 12 

5. Move the cursor in the Northwest 
direction, type 200, and then press 
<Enter> to lock in the distance. Click to 
place the second vertex, as shown in 
Figure 12. 

6. Move the cursor in the Northeast 
direction, type 100, and then press 
<Enter> to lock in the distance. Click to 
place the third vertex, as shown in    
Figure 13. 

 
Figure 13 
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7. Move the cursor in the Southeast 
direction, type 200, and then press 
<Enter> to lock in the distance. Double-
click to place the final vertex and end the 
command, as shown in Figure 13. 

8. Restart the Land Area command. 
9. Select ManacuredGrass for the style. 
10. Set the points for the vertices, as shown 

in Figure 14. 
• Ensure that you double-click the last point 

to end the command. 

 
Figure 14 

11. Select the Parking lot land area. 
12. On the Utility Bar, click  (Edit). 
13. With the parking lot Land Area still 

selected, right-click and select Properties. 
14. In the Properties palette, change the Rule 

Grading style to the new RiverParking 
grading style, as shown in Figure 15. Click 
Update. 

 
Figure 15 

15. Press <Esc> to clear the selection of the 
parking lot land area. 

16. Select the grass land area to the south of 
the parking lot. 

17. Right-click and select Properties. 
18. In the Properties palette, change the Rule 

Grading style to the Manicured Grass 
grading style. Click Update. 

19. Press <Esc> to clear the selection of the 
grass land area. 

The results are shown in Figure 16. 

 
Figure 16
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Objective 2: Transfer the Design to Civil 3D 
If you have the latest version of AutoCAD Civil 3D, you should be able to open an InfraWorks model 
directly. If you do not have the latest version of AutoCAD Civil 3D, it will be necessary to export an IMX 
file from InfraWorks, then import it in AutoCAD Civil 3D. When going the other direction (Civil 3D to 
InfraWorks) you also have the option to use .IMX files or importing the AutoCAD Civil 3D drawing file 
directly. Whether opening an InfraWorks model or an IMX file in AutoCAD Civil 3D, the same tools are 
used. The only change is the file type selection in the Select Model dialog box, as shown in Figure 17. 

 
Figure 17 

Exercise: Open an InfraWorks model in AutoCAD Civil 3D. 
In this exercise you open the existing condition 
drawing file inside AutoCAD Civil 3D that 
surveyors created. Then you bring in the 
proposed design from InfraWorks. 

1. Open AutoCAD Civil 3D. 
2. Open the FineGrading.dwg in the 

C:\CI11140-L_Grading folder. 
3. In the Insert tab>InfraWorks 360 panel, 

expand InfraWorks 360 and select  
(Open InfraWorks 360 Model). 

4. In the Open InfraWorks 360 Model dialog 
box, browse for C:\CI11140-
L_Grading\Grading.sqlite and click Open. 

5. In the Selection area, select Area of 
interest, then click Select Area… 

6. Select the area indicated in Figure 18. 

 
Figure 18 
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7. In the Object settings area, select Design 
Objects.xml, as shown in Figure 19.  

 
Figure 19 

8. Click Refine Selection Set. Select the 
AIW_Proposed Ground and review all the 
other selections, as shown in Figure 20. 
Click OK. Then click Open Model to see 
the results in AutoCAD Civil 3D. 

 
Figure 20

Compute Quantity Takeoffs 
Earthwork quantities can be calculated in two ways: 

• Create a volume surface. 
• Create Sections. 

Volume Surface 
A volume surface calculates the difference in elevations between two surfaces. When creating a surface, 
you change the type to a TIN volume surface, then set the Base and Comparison surfaces, as shown in 
Figure 21. You may find it faster to the Volumes Dashboard tool found in the Analyze tab>Volumes and 
Materials panel for calculating a quick volume surface. 
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Figure 21 

Sections 
Two types of quantity takeoffs can be calculated based on sections: earthwork volumes and material 
volumes. In order to create quantity calculations using this method, an alignment must be created. 

• Earthwork volumes represent the amount of cut (existing material above the vertical design) or 
fill (the vertical design above the existing material).  

• Material volumes are the amount of materials needed to build the road. Materials include 
asphalt pavement, concrete curbing, sub -base materials, and other materials. 

Exercise: Create a Volume Surface 
1. Continue working in the 

FineGrading.dwg. 
2. In the Analyze tab>Volumes and 

Materials panel, click  (Volumes 
Dashboard). 

3. In the Panorama, click  (Create new 
volume surface). 

4. Type Total Volume for the name. 
5. Select Existing for the Base. 
6. Select AIW_Proposed_Ground for the 

Comparison. 
7. Click OK. 
8. In the Volumes Dashboard, change the 

Cut Factor to 1.25 and the Fill Factor to 
0.75. Review the volumes.



 

Communicate the Design Visually 
Storyboards 
Storyboards are a collection of elements or keyframes that are combined together in a slide show to tell 
a compelling story about the design. The keyframes in a storyboard are generated from animations. 
These animations are either Path or Camera animations. Still images can also be incorporated using a 
Still Motion Camera animation. 

Using storyboards, you can simulate driving through the model, get a birds-eye view of the model, or 
explore the model. Figure 22 shows the Storyboard palette. 

• Storyboard Name: Displays the name of the current storyboard and enables you to edit the 
name as required. 

• Timeline: Indicates when specific elements display and how long they remain in the view before 
changing to the next element. 

• Storyboard Tools: Contains tools for creating elements and managing the storyboard. 
• Keyframe Settings: Provides settings that can be specified for the active (selected) keyframe 

element. 

  
Figure 22 

Working with the Timeline 
The Timeline identifies the sequence of the keyframes and details approximately how long each 
keyframe displays in the presentation. Keyframes can be an image, a camera animation, or a path 
animation. 
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Figure 23 shows a storyboard timeline and describes its contents. You can drag and drop keyframes to 
new locations in the timeline to change the order in which they display. You can also drag the right side 
of a keyframe to change its duration. 

• Play Head (blue square and line): Indicates where play stops and resumes during playback. 
Double-click on the timeline to move the play head to a specific location. 

• Duration: Lists the total time (i.e., start to finish) of the storyboard. 
• Playback Controls: Starts and stops the presentation at the play head location. It also enables 

you to control whether the model view follows the storyboard position. 
• Captions and Titles: Enables you to label specific views in the model to draw attention to points 

of interest. 
• Camera Paths and Animation Keyframes: Thumbnails used to indicate what is presented at 

specific times along the timeline. You can drag and drop the thumbnails to change their order or 
duration. 

• Insertion Marker (red triangle and line): Indicates where new elements display in the model 
when you add them. Click and drag the insertion marker to a location in the timeline to insert 
the next storyboard feature. 

 
Figure 23 

Keyframe Settings 
Each keyframe that you add to a storyboard has its own set of properties that can be set to control how 
the camera moves in the model. Figure 24 shows the settings for a Look Around Camera Animation 
keyframe. 
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Figure 24 

The following are areas of the Keyframe settings that are used in multiple animation types. 

• Animation Type: Lists the type of animation that was used to create the keyframe. 
• Transition Types: Enables you to set the transition type when entering and exiting the keyframe. 

There are three transition types: 
• Cut: Moves directly to the current keyframe view. 
• Fade from black: After the previous keyframe, the view displays as black. It then fades into 

the current keyframe over a duration that you set using the setting to the right of the 
Transition drop-down list, as shown in Figure 25. 

 
Figure 25 

 

• Fade from white: After the previous keyframe, the view displays as white. It then fades into 
the current keyframe over a duration that you set using the setting to the right of the 
Transition drop-down list. 

• Thumbnail Controls: Enables you to change the model view or thumbnail view. The following 
options are available for all of the animation types. 
•  (Go To Location): Quickly sets the model view to be the location of the thumbnail. 
•  (Refresh): Refreshes the thumbnail of the keyframe from the current scene content.  
• Reset: Changes the keyframe view to the current model view. 

Exercise: Communicating the Design Using 
a Storyboard 
In this exercise you will add path and camera 
animations to create a storyboard. You will create 
a presentation to show how parents will use the 
carpool lane to pick up and drop off students. You 
will use a camera path animation to simulate 
driving up to the drop off location. You will then 

add camera path animations to get a bird’s eye 
view of the school. 

1. Continue working in the same model as 
previously. If you closed it, in the Home 
Screen click Open. 



It’s a Balancing Act: BIM Workflow for Site Design 

 
 15 

 

2. In the C:\CI11140-L_Grading folder, select 
Grading.sqlite and click Open. 

3. In the Utility Bar, select Transfer for the 
Proposal. 

4. In the In Canvas Tools, click  (Create 
and conduct infrastructure design 
presentations)>  (Storyboard 
CenterCreator). 

5. In the Storyboard palette, click  (Add 
New Storyboard). 

6. In the Storyboard palette, rename the 
new storyboard as Carpool1. 

7. In the Storyboard palette, expand  (Add 
New Camera Path Animation) and select 

 (Create from Design Road).  
8. Select the CarPool Road. Several 

thumbnails appear in the timeline, as 
shown in Figure 26.  

 
Figure 26 

9. Select Keyframe 1. In the Storyboard 
Keyframe Settings area, change the Set 
speed value to 15 mph, as shown in 
Figure 27. 

 
Figure 27 

10. Move the Insertion Marker (red line) to 
the end of the keyframes. 

11. In the Storyboard palette, expand the 
Camera Animations drop-down list and 
click  (Add Pan and Zoom Animation).  

12. Ensure that the last keyframe is selected. 
In the keyframe settings, do the following, 
as shown in Figure 28 

• For Duration, click the up-arrow 
several times to set it to 10. 

• Select Distance Right, type 1800 
for the distance measurement. 

• Select Distance Up, type 100 for 
the distance measurement. 

• Select Percentage Zoom-out and 
set it to 100%. 

 
Figure 28 

13. In the Storyboard palette, click  (Play 
the current storyboard). 

14. Move the Insertion Marker to the end.  
15. In the Storyboard palette, expand the 

Camera Animations drop-down list and 
click  (Add Crane Animation).  

16. In the keyframe settings do the following,  
as shown in Figure 29. 

• In the Distance Up field, enter 50. 
•  In the Distance Back field, enter 

50 again.  
• Clear the Lock camera on center-

of-interest option. 

 
Figure 29 

1. Move the Insertion Marker to the end.  
2. In the Storyboard palette, expand the 

Camera Animations drop-down list and 
click  (Add Orbit Animation). 
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3. In the keyframe settings, do the following, 
as shown in Figure 30. 

• Select Angle right and type 90, 
and in the Angle down and type 
30. 

 
Figure 30 

4. In the Storyboard palette, click  (Play 
the current storyboard). 

 
 
 

Bonus Material 
Exporting .IMX Files 
When exporting an .IMX file to be used in the AutoCAD Civil 3D software, you can export the entire 
Autodesk InfraWorks model or a portion of the model. When you export an .IMX file, everything 
becomes part of the .IMX, including the existing conditions of features that were imported from other 
data sources. To reduce the file size and duplication of model elements in the AutoCAD Civil 3D 
software, it is recommended that you only export a portion of the model by using a bounding box or 
polyline. In addition to setting how much of the model to include in the .IMX file, you can also set the 
target coordinate system. 

Importing .IMX Files 
When importing .IMX files into an Autodesk InfraWorks model, you use the process that would be used 
to import any other data source. Importing files does not create a link to the file. Therefore, it is 
recommended that you create a new proposal before importing an .IMX file to ensure that you have a 
base model to revert to if anything changes. If the detailed design changes in the AutoCAD Civil 3D 
software, you have to create and import an updated .IMX file. 

Only certain AutoCAD Civil 3D elements can be imported into the Autodesk InfraWorks software. These 
elements include surfaces, alignments and profiles, corridor models, and pipe networks. Each element 
must be configured separately. When you import an .IMX file with multiple objects, you must select 
which type of data to include. The Choose Data Sources dialog box enables you to select the data to 
import, as shown in Figure 31. 

 
Figure 31 
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Once imported, each data type becomes its own data source in the Data Sources palette. Before they 
display in the model, the data source must be configured. The list below describes how each data source 
is handled and configured in the Autodesk InfraWorks software. 

• Surfaces: Both existing ground and finish ground surfaces can be imported, becoming terrain 
surfaces. If a grid surface is imported, it is converted into a TIN surface. Only one surface can be 
displayed in the model at a time, so you must select which surface to import in the IMX tab, in 
the Data Source Configuration dialog box, as shown in Figure 32. 

 
Figure 32 

• Alignments and Profiles: Alignments and profiles are combined into one road feature. They are 
assigned a road style in the Data Source Configuration dialog box in the Common tab, in the 
Style area. Any alignments and profiles that are used to create a corridor model are imported 
separately. For any alignments that are not associated with a corridor model, you can set the 
style in the Common tab, in the Data Source Configuration dialog box, as shown in Figure 33. 
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Figure 33 

• Corridors: Alignments and profiles that have been assigned to a corridor model in the AutoCAD 
Civil 3D software can be imported into the model in a few different ways. You can use an 
Autodesk InfraWorks road style, or you can use the AutoCAD Civil 3D corridor surface or regions 
to display the road design. If the Autodesk InfraWorks styles are used to display the corridor 
model, only one centerline alignment associated with the corridor is used to stylize the road. All 
of the other alignments associated with the corridor are ignored. When using the corridor 
surface or regions to stylize the road, two options are available in the IMX tab in the Data Source 
Configuration Dialog Box, as shown in Figure 34.  

 
Figure 34 

 
 
The two Road Options are described as follows: 

• Use Civil 3D Corridor Regions (instead of native road styles): If the corridor surface is 
used to stylize the road, the surface becomes a coverage area rather than a road 
feature. In Figure 35, the road on the left uses the native road styles and on the right it 
shows the same road using the Civil3D Corridor Regions setting. 
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Figure 35 

• Use corridor regions instead of top surface: This option creates a more detailed display 
of the road surface. The detail is sharp enough to display curbs, medians and other 
raised or lowered areas more clearly. Figure 36 shows the road that is shown on the 
right in Figure 35, but with both Road Options selected. 

 
Figure 36 

You can take advantage of both corridor regions and native road styles. By configuring 
the road twice, you can create a more realistic display. For the first time, use the 
corridor surface and regions. Then, configure it a second time to use a native road style. 
This causes the road can display the cut/fill slopes from the AutoCAD Civil 3D corridor 
model, and display the pavement markings and other details that display when using a 
native road style, as shown in Figure 37. 
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Figure 37 

• Pipe Networks: Pipes from the AutoCAD Civil 3D software become Pipes in the Autodesk 
InfraWorks software, while structures become Pipe Connectors. Pipes and Pipe Connectors 
display separately when a pipe network is imported from the AutoCAD Civil 3D software, as 
shown in Figure 38. When configuring the pipe networks, set the style in the Common tab, in 
the Data Configuration dialog box. 

 
Figure 38 

Exercise: Import an .IMX file 

1. In the In Canvas Tools, click  (Build, 
manage, and analyze your industry 

model)>  (Create and manage your 
model)>  (Data Sources). 

2. In the Data Sources palette, expand  (Add 
file data source) and select Autodesk 
IMX. 

3. In the Select Files dialog box, browse to 
the location of the file, select it, and click 
Open. 

4. In the Choose Data Source dialog box 
(shown in Figure 39) select the AutoCAD 
Civil 3D objects that you want to import. 
Click OK. 
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Figure 39 

5. In the Data Sources palette, double-click 
on the .IMX files to configure them. 

6. If it is a surface or corridor model, in the 
IMX tab, in the Data Source Configuration 
dialog box, select the required settings. 

7. Click Close & Refresh to display the 
imported data in the model. 

Exercise: Create an .IMX file in InfraWorks 
1. Continue working in the same model as 

the last exercise. 

2. In the In Canvas Tools, click  (Settings 

and Utilities)>  (Export IMX). 
3. In the Export to IMX dialog box, set the 

model extents in the Defining 
Interactively drop-down list by selecting 
BBox or Polygon (as shown in Figure 40), 
or by selecting the Use Entire Model 
option. 

 
Figure 40 

4. In the Export to IMX dialog box, set the 
target coordinate system and the target’s 
directory and filename. 

5. Click Export. 

Exercise: Create an .IMX file in AutoCAD Civil 3D 
1. Open the Civil 3D drawing file. 
2. Save the drawing file (even if you just 

opened it, it requires a save just before 
exporting.) 

3. On the Output tab>Export panel, click 

 (Export IMX). 
4. In the Command Line, select the IMX 

version required [2.1 or 2.0]. 
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